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Q.1 At which place is Harappan Dockyard found?

A. Surkotada
B. Banawali
C. Amri

D. Lothal

Answer: D

Sol: Correct Answer:D. Lothal
Explanation:
The Harappan dockyard is found at Lothal, an important site of the Indus Valley Civilization, located in present-day Gujarat, India. Lothal is
renowned for having one of the world’s earliest known dockyards, indicating the advanced maritime trade and engineering skills of the
Harappan people.

The dockyard was connected to an ancient course of the Bhogava River, which provided access to the Arabian Sea, facilitating trade with
Mesopotamia and other civilizations.

Information Booster:
¢ Location: Saragwala village, Gujarat

¢ Discovered: In 1954 by archaeologist S.R. Rao

The dockyard was used for loading and unloading cargo, showing Harappa's involvement in overseas trade.

Lothal also had a warehouse, advanced drainage system, and evidence of bead-making and metallurgy.

The presence of circular seals, weights, and scripts reflects a highly organized economic system.

Additional Information:
e Surkotada - Located in Gujarat; known for horse remains, not a dockyard.

e Banawali - Located in Haryana; known for urban planning but no dockyard.

e Amri - Located in Sindh, Pakistan; significant early Harappan site but no dockyard evidence.

Q.2 Bharat Heavy Electricals Limited (BHEL) is a company.

A. Navratna
B. Miniratna
C. Maharatna
D. Rajratna

Answer: C

Sol: The correct answer is (¢) Maharatna.
e Bharat Heavy Electricals Limited (BHEL) is an Indian central public sector undertaking and the largest government-owned electrical/ industrial
technology company. It is owned by the Government of India, with administrative control by the Ministry of Heavy Industries.
e Established in 1956 with the help of Soviet technology, BHEL is based in New Delhi.

Information Booster:

A Maharatna company is a government-owned enterprise in India that meets certain criteria, including:

e Navratna status: The company must first be a Navratna company.

e Stock listing: The company's stocks must be listed on the Indian Stock Exchange.

e Annual turnover: The company's average annual turnover over the last three years must be more than 325,000 crore. Net worth: The
company's average net worth over the last three years must be 315,000 crore.

e After-tax profit: The company must have made a profit after taxes of at least 5,000 crore over the last three years. International operations:
The company must operate internationally and have a notable global presence.
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e Some examples of Maharatna companies include:

e Bharat Heavy Electricals Limited (BHEL) -An engineering and industrial conglomerate that offers a range of products and services

e Bharat Petroleum Corporation Limited (BPCL) -A state-owned oil and gas company that operates in the upstream, midstream, and downstream
petroleum sectors

e (Coal India Limited (CIL)- The world's largest coal producer and a major contributor to India's energy sector

e GAIL (India) Limited -India's leading natural gas company that explores, produces, processes, transmits, distributes, and markets natural gas
and its by-products

¢ |ndian Oil Corporation Limited (IOCL) -India's largest oil refining and marketing company that operates refineries, pipelines, and fuel stations

e Power Finance Corporation Limited -The largest Non-Banking Financial Company (NBFC) in India

Q.3 What is 'SARVATRA' of DRDO ?

A. Satellite phone

B. Mobile phone

C. Mobile bridge making facility
D. Mobile tower

Answer: C

Sol: (c) Mobile bridge making facility
Sol.SARVATRA is a mobile, modular bridge system developed by DRDO for the Indian Army. It enables quick deployment of bridges in
war zones and disaster-hit areas, ensuring rapid mobility of troops and vehicles.

Information Booster:

e Developed by DRDO and Larsen & Toubro (L&T).

e Can span 75 meters using multiple sections.

e Helps in disaster relief and military operations.

e Used for river crossings and broken roads.

e Deployed on Indian Army trucks for quick movement.

Additional Information:

e (a) Satellite phone — Used for secure military communication.
e (b) Mobile phone — General consumer telecommunication device.
¢ (d) Mobile tower — Provides network connectivity.

Q.4 Who was the leader of the Revolt of 1857 in Kanpur?

A. Rani Lakshmibai

B. Bahadur Shah Il

C. Nana Sahib

D. Tantia Tope

E. Question Not Attempted

Answer: C

Sol: Ans. (c) Nana Sahib. Nana Sahib was the leader of the Revolt of 1857 in Kanpur. He led the rebellion against the British forces, capturing Kanpur and
proclaiming himself as the Peshwa. He was assisted by his general, Tantia Tope, in the uprising.
Information Booster:
1. Nana Sahib was the adopted son of the last Peshwa, Baji Rao II.
2. His primary grievance was the refusal of the British to grant him the pension due to the Peshwa family after the annexation of his estate under the
Doctrine of Lapse.
3. The revolt in Kanpur was marked by the capture of the British garrison and the subsequent massacre of British soldiers and civilians.
4. After the fall of Kanpur, Nana Sahib fled and continued his resistance against the British.
5. The revolt in Kanpur is one of the most remembered episodes of the 1857 uprising for its intense fighting and tragic events.
6. Nana Sahib’s whereabouts after the revolt remain unknown, and he became a symbol of resistance against British rule.

Q.5 Pradhan Mantri Gramin Awas Yojana was earlier known as-

A. Indira Awas Yojana
B. Nehru Awas Yojana
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C. Rajiv Awas Yojana
D. Rashtriya Awas Yojana

Answer: A

Sol: The correct answer is (a) Indira Awas Yojana

Explanation:

e The Pradhan Mantri Gramin Awas Yojana (PMAY-G) is a restructured version of the Indira Awas Yojana (I1AY).

e The IAY was launched in 1985 by the Government of India as part of the then-Prime Minister Rajiv Gandhi's vision to provide housing for the
rural poor.

e The IAY was restructured and renamed as PMAY-G on April 1, 2016, to address previous deficiencies and provide permanent (pucca) houses
to all homeless rural families and those living in dilapidated houses.

Information Booster:

e PMAY-G is a flagship social welfare program of the Central Government of India.

e [t aims to provide financial assistance to eligible rural households for the construction of pucca houses.

e Beneficiaries are identified using the housing deprivation parameters of the Socio-Economic Caste Census (SECC) 2011 data, and the list is
validated by the Gram Sabha.

e The funding for PMAY-G is shared between the Central and State Governments.

Additional Knowledge:

Nehru Awas Yojana (Option b)

e There is no prominent central government housing scheme known as Nehru Awas Yojana. The option is incorrect.

Rajiv Awas Yojana (Option )

e The Rajiv Awas Yojana was a central government scheme launched in 2011 to address the issue of urban slums. It aimed to make India "slum-
free" and was later subsumed under the Pradhan Mantri Awas Yojana - Urban (PMAY-U).

Rashtriya Awas Yojana (Option d)

e This is not the official name of any central government housing scheme. The option is incorrect.

Q.6 Who among the following founded the Harijan Sevak Sangh in 1932?

A. Maharshi VR Shinde
B. Mahatma Gandhi

C. BR Ambedkar

D. Swami Vivekanand

Answer: B

Sol: The correct answer is (B) Mahatma Gandhi
Explanation:
e The Harijan Sevak Sangh was founded by Mahatma Gandhi in 1932 to work for the social, economic, and educational upliftment of the Dalits
(then called Harijans).
e |t aimed to eradicate untouchability and promote equality in Indian society during the freedom struggle.
e The headquarters of the organization is located in Delhi.
Information Booster:
e Founded in 1932 by Gandhi.
e Focused on upliftment of Dalits.
e Worked against untouchability.
e Headquarters — Delhi.
e Still active as an NGO in India.
Additional Knowledge (Other Options):
e Maharshi VR Shinde — Founded Depressed Classes Mission (1906).
e BR Ambedkar — Led Dalit movement; founded Bahishkrit Hitakarini Sabha (1924).
e Swami Vivekanand — Founded Ramakrishna Mission (1897).


https://www.adda247.com/
https://applink.adda247.com/d/XhqWf9lSap

Adda = |V GGESIJOgI\ie Play

Q.7 In molecular biology, the process of synthesizing an RNA molecule from a DNA template is known as

A. Transcription
B. Replication

C. Transformation
D. Translation

Answer: A

Sol: The correct answer is (a) Transcription

Explanation:

- Transcription is the process by which a segment of DNA is copied into RNA (specifically, messenger RNA or mRNA) by the enzyme RNA
polymerase.

* This process occurs in the nucleus of eukaryotic cells and the cytoplasm of prokaryotic cells.

» The RNA molecule produced carries the genetic information from the DNA to the ribosomes, where it directs protein synthesis.

« Transcription is the first step of gene expression, an essential part of the central dogma of molecular biology (DNA -> RNA -> Protein).

Information Booster:

« In transcription, the nucleotide bases pair up in a specific way: Adenine (A) pairs with Uracil (U) (instead of Thymine (T) as in DNA), Thymine (T) pairs
with Adenine (A), Cytosine (C) pairs with Guanine (G), and Guanine (G) pairs with Cytosine (C).

» The promoter region on the DNA sequence is where RNA polymerase binds to initiate transcription.

¢ The process stops when the polymerase reaches a terminator sequence.

Additional Knowledge:

Replication (Option b)

* Replication is the process by which a DNA molecule makes a copy of itself, ensuring that each new cell receives an identical set of genetic
instructions during cell division. This process involves DNA polymerase, not RNA synthesis.

Transformation (Option c)
- Transformation is a process by which foreign genetic material (DNA) is directly incorporated into a bacterial cell or a eukaryotic cell, altering its
genetic makeup. It is a method of genetic transfer, not the synthesis of an RNA molecule from a DNA template.

Translation (Option d)
- Translation is the process where the genetic code carried by mRNA is decoded by a ribosome to produce a specific sequence of amino acids (a
protein). This occurs after transcription, not during it.

Q.8 Which of the following was India's first Lunar Mission?

A. Aditya

B. AVATAR

C. Chandrayaan-1
D. ASTROSAT

Answer: C

Sol: The correct answer is (c) Chandrayaan-1.

Explanation:

« Chandrayaan-1 was India's first lunar mission, launched by the Indian Space Research Organisation (ISRO).

« It was launched on October 22, 2008, from the Satish Dhawan Space Centre, Sriharikota, Andhra Pradesh.

 The mission aimed to orbit the Moon and map its surface, gather data on its mineralogy, and search for water ice.

« A significant achievement of Chandrayaan-1 was the detection of water molecules on the lunar surface by its Moon Impact Probe (MIP) and the
Moon Mineralogy Mapper (M3) payload.

Information Booster:

» Chandrayaan-1's mission duration was initially planned for two years, but it concluded prematurely on August 29, 2009, after 312 days in orbit due
to technical issues.

« Despite the early termination, the mission successfully achieved most of its scientific objectives and provided valuable data.

» The mission played a crucial role in establishing India's capabilities in planetary exploration.

Additional Knowledge:

Aditya (Option a)

 Aditya-L1 is India's first dedicated mission to study the Sun, not the Moon.

« It is designed to study the solar atmosphere, coronal mass ejections, and solar flares.
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AVATAR (Option b)

- AVATAR (Aerobic Vehicle for Transatmospheric Hypersonic Aerospace TrANsportation) is a conceptual Indian reusable launch vehicle
program, not a lunar mission.

« It is a proposed project aimed at developing a single-stage-to-orbit reusable launch vehicle.

ASTROSAT (Option d)
« ASTROSAT is India's first dedicated multi-wavelength space observatory.
« It was launched in 2015 to conduct studies in astronomy, observing celestial bodies across different wavelengths, from ultraviolet to X-ray.

Q.9 is the name of an Indian Light Combat Aircraft

A. Chetak
B. Tejas
C. Rudra
D. Dhruv

Answer: B

Sol: The correct answer is (B) Tejas.
Explanation:
« Tejas is the name of the indigenously designed and developed Indian Light Combat Aircraft (LCA).
* It is a single-engine, multi-role supersonic fighter aircraft, developed by the Aeronautical Development Agency (ADA) and manufactured
by Hindustan Aeronautics Limited (HAL).
« The project was initiated to replace the Indian Air Force's aging fleet of MiG-21 fighter planes.

Information Booster:

« The aircraft was officially named 'Tejas’, meaning ‘radiance’ in Sanskrit, by former Prime Minister Atal Bihari Vajpayee in 2003.

« Tejas is the smallest and lightest multi-role supersonic fighter aircraft in its class, and features a tailless, compound delta-wing design.
« Itis a part of India’s larger effort toward achieving self-reliance in defense manufacturing under the Atmanirbhar Bharat initiative.

Additional Knowledge:

(A) Chetak:

« Chetak is a light utility helicopter, not a fixed-wing combat aircraft.

« It is manufactured by HAL under license from the French company Sud Aviation (now Airbus Helicopters).

(C©) Rudra:
* Rudra is an armed helicopter, which is the weaponized version of the Advanced Light Helicopter (Dhruv).
« It is also indigenously developed and manufactured by HAL but is not a fixed-wing combat aircraft.

(D) Dhruv:
* Dhruv is an Advanced Light Helicopter (ALH), a multi-role, multi-mission utility helicopter.
« Like the Rudra, it is developed by HAL, but it is a helicopter, not a Light Combat Aircraft

Q.10 In which tournament in 2018 did Neeraj Chopra become the first Indian javelin thrower to win a gold medal?

A. World Championships

B. Olympic Games

C. Asian Games

D. Asian U20 Championships

Answer: C

Sol: The Correct Answer is C: Asian Games
Explanation
Neeraj Chopra won the gold medal in javelin throw at the 2018 Asian Games, becoming the first Indian to achieve this feat with a throw of 88.06
meters.

Key Points

¢ Neeraj Chopra made history by winning the gold medal at the 2018 Asian Games.
e This win qualified him for the Tokyo 2020 Olympics.

Additional Information
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e World Championships: Neeraj Chopra participated but did not win a gold.
e Olympic Games: Neeraj won gold in Tokyo 2020, not in 2018.
¢ Asian U20 Championships: Neeraj had prior successes, but not the gold medal in 2018.

Q.11 Which international organisation is the current governing body of Badminton?

A. Badminton World Federation

B. International Badminton Committee
C. International Paralympic Committee
D. International Olympic Committee

Answer: A

Sol: The correct answer is (a) Badminton World Federation

Explanation:

e The Badminton World Federation (BWF) is the current international governing body for badminton.
e [tis responsible for organizing major international tournaments, setting rules, and promoting the sport worldwide.

Information Booster:

e BWF was formerly known as International Badminton Federation (IBF) before 2006.
e Headquarters: Kuala Lumpur, Malaysia.

e Oversees events like BWF World Championships and BWF World Tour.

e Promotes development of badminton globally, including para-badminton.

e Ensures standardized rules and regulations for international competitions.

Q.12 Which of the following industrialists was awarded the Padma Bhushan 2023 in the field of Trade and Industry ?

A. Mukesh Ambani

B. Kumar Mangalam Birla
C. Adar Poonawalla

D. Gautam Adani

Answer: B

Sol: The correct answer is (B) Kumar Mangalam Birla.

Explanation:
In the list of the 2023 Padma Bhushan awardees published by the Press Information Bureau (PIB), the industrialist Kumar Mangalam Birla was honored

under the category “Trade & Industry”.
None of the other listed industrialists in the options (Mukesh Ambani, Adar Poonawalla or Gautam Adani) appear in the 2023 Padma Bhushan list

under Trade & Industry according to the official announcement.
Additional Information:

The Padma Bhushan is the third-highest civilian award in India.
The announcement for 2023 shows nine recipients of the Padma Bhushan. Among them, Kumar Mangalam Birla is the only one recognized in the

Trade & Industry category for that year.

Q.13 Who is the winner of ‘Subhash Bose Aapda Prabandhan Puraskar 2022"?

A. Dr. Rajendra kumar Bhandari
B. Dr. Akhil Goyal

C. Dr. Rajveer Singh

D. Vinod Sharma

Answer: D

Sol: The correct answer is (D) Vinod Sharma
Explanation:
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* In 2022, the Subhash Chandra Bose Aapda Prabandhan Puraskar was awarded to Professor Vinod Sharma in the individual category, and
to the Gujarat Institute of Disaster Management (GIDM) in the institutional category .

Information Booster:

« Prof. Vinod Sharma is a pioneer in Disaster Risk Reduction (DRR) in India, founder-coordinator of the erstwhile National Centre for Disaster
Management (now NIDM), and serves as Vice Chairman of Sikkim State Disaster Management Authority.
* The prestigious award carries a cash prize of ¥5 lakh for individuals and a certificate, alongside 351 lakh for institutions .

Additional Knowledge:

¢ Dr. Rajendra Kumar Bhandari received the individual award for 2021, not 2022.
e Dr. Akhil Goyal and Dr. Rajveer Singh are not listed among official awardees for these years.

Q.14 How many accounts had been opened under the Pradhan Mantri Jan Dhan Yojana by October 2024?

A. 53 crore
B. 40 crore
C. 60 crore
D. 25 crore

Answer: A

Sol: The correct answer is: (a) ~53 crore
Explanation:
As of October 2024, the Pradhan Mantri Jan Dhan Yojana (PMJDY) had successfully opened approximately 53 crore bank accounts across
India.
This initiative, launched in August 2014, aims to provide universal access to banking facilities, especially for the unbanked population, thereby
promoting financial inclusion.
Information Booster:
e Overdraft Facility: Eligible account holders can avail an overdraft facility of up to ¥10,000, providing financial support during emergencies.

e Deposits: These accounts collectively hold a deposit balance of approximately ¥2.31 lakh crore.

e Women Beneficiaries: Around 55.6% of the account holders are women.

Rural Reach: Approximately 66.6% of the accounts are in rural and semi-urban areas.

RuPay Cards Issued: Over 36 crore free-of-cost RuPay debit cards have been issued to beneficiaries.

Q.15 Which of the following initiatives was introduced in 2014 to boost the industrial sector by making India a global manufacturing hub?

A. National Manufacturing Policy
B. Atal Innovation Mission

C. Skill India Programme

D. Make in India

Answer: D

Sol: The correct answer is (d) Make in India

Explanation:

« The Make in India initiative was launched by the Government of India on 25th September 2014.

« It aims to transform India into a global design and manufacturing hub.

« The initiative encourages both domestic and foreign companies to manufacture their products in India.
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« It focuses on key sectors such as automobiles, textiles, electronics, defence manufacturing, etc.

« It promotes Ease of Doing Business, FDI liberalization, and infrastructure development.

Information Booster:

 Make in India has helped boost FDI inflows and employment generation in the manufacturing sector.

« It complements other flagship schemes like Startup India, Skill India, and Digital India.

Additional Knowledge:

National Manufacturing Policy (Option a)

* Launched in 2011, aiming to increase the share of manufacturing in GDP to 25% by 2022.

» Preceded Make in India and is not the initiative launched in 2014.

Atal Innovation Mission (Option b)

« Launched in 2016 under NITI Aayog.

« Focuses on fostering innovation and entrepreneurship, especially among youth.

Skill India Programme (Option c)

* Launched in 2015, aimed at equipping youth with industry-relevant skills.

« Supports manufacturing indirectly but wasn’t launched in 2014.

Q.16 How many countries are member countries of the Asian Development Bank (ADB)?

78
94
103
68

OnNnw >

Answer: D

Sol: The correct answer is (D) 68
Explanation:
e The Asian Development Bank (ADB) has a total of 68 member countries.
e This includes 49 countries from the Asia-Pacific region and 19 non-regional members.

e ADB works to promote economic development, reduce poverty, and support infrastructure projects in Asia.
Information Booster:

e Total member countries — 68

e Founded in 1966 (Headquarters: Manila, Philippines)

e India joined 1966 as a founding member

e Largest shareholders — Japan & USA

e Current President - Masatsugu Asakawa (as of 2025)

Q.17 In which year was the llbert Bill proposed?

1891
. 1883
. 1873
. 1879

N w >
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Answer: B

Sol: The correct answer is (B) 1883
Explanation:
e The llbert Bill was proposed in 1883 by Lord Ripon, the Viceroy of India.
e |t aimed to allow Indian judges to try British offenders in criminal cases, which sparked strong opposition from Europeans in India.
e The bill led to a major controversy and was eventually diluted.
Information Booster:
e Proposed by Lord Ripon in 1883.
e Opposed by British residents in India.
e Concerned judicial rights for Indians.
e Led to racial tensions & protests.
e Strengthened Indian nationalism.
Additional Knowledge (Other Options):
e 1891 — Factory Act was passed.
e 1873 — Vernacular Press Act introduced.
e 1879 — Second Anglo-Afghan War period.

Q.18 Select the set in which the numbers are related in the same way as are the numbers of the following sets.
(NOTE: Operations should be performed on the whole numbers, without breaking down the numbers into its constituent digits. E.g. 13 -
Operations on 13 such as adding/deleting/multiplying etc. to 13 can be performed. Breaking down 13 into 1 and 3 and then performing
mathematical operations on 1 and 3 is not allowed)
(64,12, 4)
(128, 19, 3)

A (72,21, 11)
B. (70, 21, 12)
C. (72,21, 12)
D. (72, 20, 12)

Answer: C

Sol: Given:
(64,12, 4)
(128, 19, 3)
Logic: (1st number + 8) + 3rd number = 2nd number
For, (64, 12, 4)
64 +8=88+4=12
For, (128, 19, 3)
128 +8=16,16 +3 =19
Now, we check each options.
Option (a): (72, 21, 11) (Not Follow)
72+8=99+11#£21
Option (b): (70, 21, 12) (Not Follow)
70 - 8+#£9
Option (c): (72, 21, 12) (Follow)
72 +8=99+12=21
Option (d): (72, 20, 12) (Not Follow)
72+8=99+12£20
Thus, correct option is (c).

Q.19 Rod is to metal in the same way flute is to:

. Sound
. Bamboo
. Player

N w >

. Hole

Answer: B

Sol: Given:
Rod : Metal :: Flute : ?
Rod is to metal — A rod is made of metal.
Similarly, a flute is made of what?
Flutes are usually made of bamboo.
Thus, correct option is (b).
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Q.20 Select the figure that is related to the third figure in the same way as the second figure is related to the first figure.

AN

EEEILE

e
A.
°
B.
°
e
C.
°
AN
5 L]
. H o
Answer: B

Sol: Logic: Figure is rotating clock wise direction at 90 degree.

£ ||
' el o

Thus, correct option is (b).

Q.21 If + means -, - means X, X means —, — means +, then, whatis6 + (4 X 2)-3 +-1=7?

A.0
B.2
C.3
D. 1

Answer: D

Sol: Given: 6+ (4 X 2)-3+1=7

Given Sign+ - X+

New Sign - X+

Using BODMAS rule.
Operation preference wise Symbol
Brackets ,,0)
Orders, of (power), v/(root),of
Division =
Multiplication X
Addition +
Subtraction —
New equation: 6 - (4 =-2) X 3 +1=7
6-2X3+1=7

6-6+1=7
7-6=7
?=1

Thus, correct option is (d).
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Q.22 Sele_ct the option in which the given figure (X) is embedded (rotation is NOT allowed.)

oo

X)
—®

A ga’

b
s

Answer: A

Sol: The correct embedded figure is shown below:

of

X) —

Thus, the correct option is (a).

Q.23 Select the option figure that can replace the question mark (?) in the figure given below to complete the pattern.

OA | AO

Al

~

B.| O/

cl A

D.| (] A\

Answer: B

Sol: The logic followed here is-
Logic: The pattern on the upper part is repeated onto the lower part as follows-
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OA | AO

Al

~

Therefore, we get the final pattern as-

QA | AD

OA

AL

Hence. the correct answer is "Option B™.

Q.24 Based on the English alphabetical order, three of the following four letter-clusters are alike in a certain way and thus form a group. Which letter-
cluster DOES NOT belong to that group? (Note: The odd man out is not based on the number of consonants/vowels or their position in the letter-
cluster.)

A. KAQ
B. RHX
C. WMC
D. QEU

Answer: D

Sol: [ Tolslals]el7]sa]of10]11]12]13

=]
=

26|25 |24 |23 |22 |21 | 20|19 1817 | 16| 15 |14

Logic: 1st letters - 10 = 2nd letters, 2nd letters + 16 = 3rd letters.
Let's check all the options:

Option (a): KAQ

K-10=A A+16=Q

Option (b): RHX

R-10=H,H+16=X

Option (c): WMC

W-10=M,M+16=C

Option (d): QEU

Q-12=EE+15=U

There are only three options A, B, C which are following the same logic.
So, the correct odd one out is QEU.

Thus, the correct option is (d) QEU.

Q.25 In the following question, select the odd letter/letters from the given alternatives.

A EV
B. MN
C. DX
D. AZ

Answer: C

Sol: |1 |2 (3|4|s5]|6|7|8]9]|10]11]12]|13
AB|IC|ID|E|F|G|H|I]|]J]K

WIVIU|T|S|R|Q|P|O|N
26 |25 |24 |23 |22|21|20( 19| 18|17 | 16| 15|14

Opposite letters = Sum of positions = 27
Check each:
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a)EV:5+ 22 =27

b) M N: 13 + 14 = 27
cDX: 4+ 24 =28 # 27
d)AZ:1+26=27

Thus, correct option is (c).

Q.26 Rearrange the jumbled letters to makes meaningful English word and then select the on which is different.

A. OLYGBOI

B. AEVLTR

C. YCEIHRTSM
D. HISCYPS

Answer: B

Sol: Let's rearrange the given words:
Option (a): OLYGBOI — BIOLOGY
Option (b): AEVLTR — TRAVEL
Option (c): YCEIHRTSM — CHEMISTRY
Option (d): HISCYPS — PHYSICS
BIOLOGY, CHEMISTRY and PHYSICS are all science subjects.
TRAVEL is not a science subject.
So, the word that is different is: TRAVEL
Thus, correct option is (b).

Q.27 Data was gathered from a survey as to what sport was liked by the people surveyed. The data was represented by a pie chart, and the sector
representing people who liked soccer had a central angle of 54°. What percentage of the people surveyed liked soccer?

A. 10%
B. 12.5%
C. 20%
D. 15%

Answer: D

Sol: Given:
- Central angle representing people who liked soccer = 54°

- Total angle in a circle = 360°

Formula Used:

Centralangl
Percentage of people liking soccer = (%) x 100
Solution:
54 (54 x 100)
P tage = (— 100 = — = =15
ercentage (360) X 360 %

15% of the people surveyed liked soccer.
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Q.28 In which year the sales of Store C is less compared to the other two years

Sales of Stores

16

14

12
| I II
0 II

Year 1 Year 2 Year 3

=]

(=2}

S

S}

W Store A W Store B Store C

A. Year 1
B. The sales is consistent over the three years
C. Year 3
D. Year 2

Answer: C

Sol: Solution:

Sale of store A on year 1 = 12 units
Sale of store B on year 1 = 14 units
Sale of store C on year 1 = 14 units
Sale of store A on year 2 = 10 units
Sale of store B on year 2 = 12 units
Sale of store C on year 2 = 13 units
Sale of store A on year 3 = 9 units
Sale of store B on year 3 = 8 units
Sale of store C on year 3 = 5 units
In year 3 sales of store C is less compared to other two years

Q.29 The given chart represents the import of various consumer goods (in Lakh tons) during the years 2016-2020.

Import of various consumer goods (in Lakh tons)
during the years 2016-2020

40

35

30 /\\
25
20 —Electroni

15 ——Toys
10

Cosmetic

2016 2017 2018 2019 2020
Years

What is the ratio of the number of cosmetics imported in years 2016 and 2020 together to that of toys in the year 2018 and 2020 together?

A7:6
B.5:2
C.4:3
D.3:1
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Answer: C

Sol: Solution:
Extract data from the chart.
- Cosmetics in 2016 = 35 lakh tons
- Cosmetics in 2020 = 25 lakh tons
- Toys in 2018 = 25 lakh tons
- Toys in 2020 = 20 lakh tons
Calculate the sum for cosmetics in 2016 and 2020.
Sum (Cosmetics) = 35 + 25 = 60 lakh tons
Calculate the sum for toys in 2018 and 2020.
Sum (Toys) = 25 + 20 = 45 lakh tons
Find the ratio.
Ratio = Sum (Cosmetics) : Sum (Toys) = 60:45 =4:3

Q.30 If | bought a watch of Rs. 5000 and paid 6% tax and 12% tax on Rs. 15000 mobile phone. So | paid approximately how much tax on both the
items?

2
A 18- %
B.15= %
2

1
C.10-%
2

D. 15%

Answer: C

Sol: Given:
Cost of the watch = 5,000

Tax rate on the watch = 6%
Cost of the mobile phone = 315,000
Tax rate on the mobile phone = 12%

Formula Used:

Cost x Tax Rate
100

Tax =

Solution:

Tax on the watch:

5000 x 6
BT

Tax on the mobile phone:

15000 x 12
— = 1800
100

Total tax paid = 300 + 1800 = 32100
Total cost of both items = Rs. 5000 + Rs. 15000
Total cost = Rs. 20000

Percentage of tax paid on both items:

Total tax

—— x 100
Total cost

Tax percentage =

2100

1
20000 ~ 190

Tax percentage =

Tax percentage =1 05%
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Q.31 If the side of a square is increased by 35 percent, then by what percent will its perimeter increase?

A. 17 percent
B. 35 percent
C. 25 percent
D. 20 percent

Answer: B

Sol: Given:
The side of the square is increased by 35%.

Formula Used:

Perimeter of a square: P = 4 xside

Solution:

Let the original side of the square be ('s ). Then the original perimeter is:
Poriginal = 4s

After increasing the side by 35%, the new side becomes:

Spew = 8 + 0.35s = 1.35s

Now, the new perimeter becomes:

Ppew =4 x 1.355s = b.4s
The increase in perimeter is:

Increase in perimeter = Pyew — Poriginal = 9.45 —4s = 1.4s

I . imet 14
ncrease in perimeter 100 = —=% 100 = 35%
Poriginal 4s

Percentage increase =

Q.32 [f162:y:y:128, find the positive value of y.

A. 142
B. 144
C. 153
D. 140

Answer: B

Sol: Given:
162:y:y:128

Solution:

162y
128

y? = 20736

y =v/20736 = 144
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Q.33 The average of 40 numbers is 65. If each of these 40 numbers is increased by 5, what will be the new average?

A. 60
B. 70
C. 140
D. 210

Answer: B

Sol: Given:
Old average = 65
Each number is increased by 5
Number of values = 40
Formula used:
New average = Old average + Increase per number
Solution:
New average = 65 + 5 =70
Correct answer is (B)

Q.34 At what simple rate of interest a sum is double in 8 years ?

.11.0%
125 %
.12 %
.135%

O N w >

Answer: B

Sol: 1. Substitute the known valuesSimple Interest (SI) = (Principal x Rate x Time) / 100
2. Let the principal amount be 'P".

Time (T) = 8 years

Simple Interest (SI) = P (since the sum doubles)
P=(P*R*8)/100

1=(R*8)/100

R=100/8
R=125%

Q.35 In how many years interest of 3,000 will be "1,080 at the simple interest rate of 12% annually?

A. 3 years
B. 2 %years
C. 2 years

1
D. 3 S years

Answer: A
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_ Pre

Sol: S§[=—
100
F000 12« ¢

=1080=
100
T = 3 years.

Q.36 A trader sells a watch at the profit of 30 percent. Had he bought that watch at 20 percent less price and sold it at Rs. 60 less, then he would have
earned a profit of 30 percent. What is the cost price of the watch?

A. Rs. 250
B. Rs. 225
C. Rs. 326.66
D. Rs. 230.76

Answer: D

Sol: Given:
Original profit = 30% on cost price (CP)

If bought at 20% less and sold at 60 less than original SP, profit would be 30%
Find original CP

Formula Used:

Selling Price with p% profit: SP = (1 * 1€;0> < OP

Solution:
Let original cost price be x.

Original SP: SP; = 1.3z

New CP 20% less: 0.8x.

For 30% profit on this: SP2 = 1.3 x 0.8z = 1.04x
Also given: SPy = SP;—60

1.04x = 1.3x - 60
1.3x - 1.04x = 60

0.26x = 60

60 3000
2 930.76.
X026 13 30.76

So, Cost Price = ¥230.76.

Q.37 A, B and C started a business by investing Rs. 1,20,000, Rs. 1,35,000 and Rs. 1,50,000 respectively. Find the share of each out of
an annual profit of Rs. 56,700.

A. A's share = 16800, B's share = 18900, C's share = 21000.
B. A's share = 14800, B's share = 13900, C's share = 21000.
C. A's share = 16400, B's share = 11900, C's share = 23000.
D. None of these

Answer: A
Sol: Given:

A, B and C started a business by investing Rs. 1,20,000, Rs. 1,35,000 and Rs. 1,50,000 respectively. The annual profit is Rs. 56,700. We need to find the
share of each person out of the profit.
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Formula Used:
The profit is divided in the ratio of their investments.
Solution:

Let the shares of A, B, and C be in the ratio of their investments. The investments of A, B, and C are Rs. 1,20,000, Rs. 1,35,000, and Rs. 1,50,000
respectively.

The ratio of their investments is: 120000 : 135000 : 150000. We can simplify this ratio by dividing each term by 5000.
Thus, the simplified ratio is: 24 : 27 : 30.
Now, the total ratio is: 24 + 27 + 30 = 81.

The total profit is Rs. 56,700. We divide this profit according to the ratio 24 : 27 : 30.
24 27 30
A's share = (ﬁ) x 56700 = 16800, B's share = (8—1) x 56700 = 18900, C's share = (8—1) x 56700 = 21000.

Thus, the shares of A, B, and C in the annual profit are Rs. 16,800, Rs. 18,900, and Rs. 21,000 respectively.

Q.38 Hari travels from City A to City B. If Hari drives his car at 1/8 of his normal speed, then he reaches City B 21 minutes late. Find the time (in minutes)
that Hari would have taken to travel from City A to City B if he drove at his normal speed.

A1
B.3
C7
D. 11

Answer: B

Sol: Given:

1
When Hari drives at g of his normal speed, he is 21 minutes late.

Concept Used:
Time is inversely proportional to speed.
Solution:

Let the time taken at normal speed be t minutes
: L
So if speed becomes g time becomes 8t

The difference between slow time and normal time = 21 minutes

So,

8t-t=21

7t = 21

=23
7

Thus, Time at normal speed = 3 minutes
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Q.39 Address 1: Dr. Ramesh Agarwal, 305/2, Liberty Road, Jaipur - 302001
Address 2: Dr. Ramesh Agarwal, 305/2, Liberty Road, Jaipur - 302001

Are these likely to be the same?

A. No, the house numbers do not match
B. Yes, all major details match

C. No, the surnames are different

D. No, the city names are different

Answer: B

Sol: The house number, road name, and postal code are the same. The only difference is in the surname spelling, which could be a typo or a difference in
personal preference.

Conclusion: The addresses are likely the same with a minor surname difference.

Correct Answer:
B) Yes, all major details match

Q.40 Address A: Priya Sharma, 15/3, MG Road, Bangalore - 560001
Address B: P. Sharma, 15/3A, MG Road, Bangalore - 560001
What is the most significant difference between the two addresses?

. Different road
. Different house number
. Different surname

O N w >

. Different postal code

Answer: B

Sol: Given: The two addresses are compared.
Analysis: The only significant difference between the two addresses is the house number. Address A has "15/3", while Address B has "15/3A".
Conclusion: The most significant difference is the house number.

Correct Answer:
B) Different house number

Q.41  Which of the following is an Open Source Operating System?

A. MacOS

B. UNIX

C. Android

D. MS Windows

Answer: C

Sol: Android is an open-source operating system developed primarily by Google, based on the Linux kernel. It is used in smartphones, tablets,
and various embedded devices. Being open-source, developers can access its code and modify it for custom uses.
Important Key Points:

1. Android is open-source under the Apache License, allowing free distribution and modification.
2. Many manufacturers (Samsung, Xiaomi, OnePlus) use Android and customize it.
3. While Android is open-source, some Google services included are proprietary.

Knowledge Booster:
* MacOS - Proprietary OS by Apple.

* UNIX - Not fully open-source; it is licensed but inspired many open systems like Linux.
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Q.42 The speed of clock frequency of a microprocessor is measured in

A. hertz

B. baud rate
C.CPS

D. bits

E. MIPS

Answer: A

Sol: The speed of the clock frequency of a microprocessor is measured in hertz (Hz). The clock frequency determines how many cycles per second the
processor can execute, directly affecting the speed at which it processes instructions.
- Important Key Points:

1. Hertz (Hz) is the standard unit of frequency, used to measure the clock speed of processors.
2. Baud rate measures the speed of data transmission over a communication channel.

3. MIPS (Million Instructions Per Second) is another metric for processor speed, indicating the number of instructions a CPU can execute per second.
- Knowledge Booster:

. Overclocking: Increasing the clock speed beyond the manufacturer’s specifications can lead to higher performance but may also cause instability or
overheating.

Q.43 Which of the following groups is NOT present in the ‘Insert’ tab of MS Excel?

A. Illustrations
B. Paragraph
C. Links

D. Symbols

Answer: B

Sol: The Correct Answer is (B) Paragraph
Explanation:

The “Insert’ tab in MS Excel does not have a Paragraph group. The Paragraph group is part of the ‘Home’ tab in MS Word and is used for
formatting text, alignment, and paragraphs. The “Insert’ tab in Excel includes groups like lllustrations, Links, and Symbols, which are used for
inserting images, hyperlinks, and symbols, respectively.

Information Booster:

The “Insert’ tab in Excel is used for adding elements like charts, pictures, tables, hyperlinks, symbols, and more.

The “lllustrations’ group in Excel includes options like Pictures, Shapes, SmartArt, etc.

The “Links’ group in Excel includes options for adding hyperlinks and managing links.

The “Symbols’ group in Excel allows users to insert special characters and symbols into their worksheet.

Additional Information:

e Paragraph: This group is not present in the Insert tab of Excel. It is found in the Home tab of MS Word, where it is used for text formatting.

Q.44 is not a basic function of MS Excel.

A. count()
B. sum()
C. max()
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D. addition()

Answer: D

Sol: The function addition() is not a recognized function in MS Excel. To add values in Excel, the SUM() function is used. The count(), sum(), and
max() are valid and widely used functions in Excel for counting values, summing values, and finding the maximum value in a range, respectively.
Important Key Points:

1. count(): The count() function in Excel counts the number of cells that contain numerical data within a specified range.
2. sum(): The sum() function adds up the values in a range of cells.

3. max(): The max() function returns the highest value in a given range of cells.

4. addition():addition() is not a valid function in Excel. Instead, the SUM() function is used for addition in Excel.

Q.45 Compatibility, with regard to computers, refers to .

A. The software doing the right job for the user

B. It being versatile enough to handle the job

C. The software being able to run on the computer

D. Software running with only other previously installed software
E. Software permanently available in the computer

Answer: C

Sol: In computer terminology, compatibility refers to the ability of software or hardware to function properly on a specific system or platform. For
software, it means that it can be installed, executed, and perform its tasks on a computer with the specified hardware and operating system
configuration.

Important Key Points:

1. Software compatibility ensures smooth execution without errors on the target system.

2. Factors affecting compatibility include hardware specifications, operating system version, and required drivers.

3. Compatibility can also apply to hardware devices like printers or external drives working correctly with a computer.
Knowledge Booster:

- The software doing the right job for the user: Refers to functionality, not compatibility.

- Being versatile enough to handle the job: Refers to flexibility, not compatibility.

- Software running with only other previously installed software: This defines dependency, not compatibility.

- Software permanently available in the computer: Refers to built-in software, unrelated to compatibility.

Q.46 MS - PowerPoint presentations use pre-created design styles to regulate the layout, color schemes, and formatting that are known as:

A. Templates

B. Blueprints
C. Placeholders
D. Auto styles

Answer: A

Sol: In MS PowerPoint, templates are pre-designed slide layouts that control the structure, design, fonts, colors, and overall look of the presentation.
Templates are used to ensure consistency in style and appearance across slides, helping users create visually appealing presentations quickly without
manually adjusting each slide’s formatting.

Important Key Points:

1. Templates: Pre-designed slide layouts that include style, color schemes, font choices, and formatting. Templates provide a consistent design
across all slides in a presentation.

2. Ease of Use: Templates make it easier for users to create professional-looking presentations without the need to design slides from scratch.

3. Customization: While templates offer a base design, users can modify content, images, and text within the template framework.

Knowledge Booster:

- Blueprints: Blueprints are typically used in architectural design and do not apply to PowerPoint presentations. PowerPoint uses templates for slide
layouts.

- Placeholders: Placeholders are specific areas within a slide that hold text, images, or other elements. They are not used for regulating overall
design styles.

- Auto styles: Auto styles generally refer to automatic formatting settings applied to text or objects, but they do not regulate the overall design of a
presentation like templates do.

Q.47 Which type of view is not present in MS-PowerPoint?

A. Extreme animation
B. Slide show
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C. Slide sorter
D. Normal

Answer: A

Sol: "Extreme animation” is not a type of view in Microsoft PowerPoint. MS PowerPoint provides various views designed to facilitate creating, editing,
arranging, and presenting slides effectively. However, "Extreme animation" is neither a recognized nor a standard view; instead, animation is a feature
applied to slide elements rather than a distinct view mode.

Important Key Points:

1. MS-PowerPoint views include Normal view, Slide Sorter view, Slide Show view, Outline view, and Notes Page view.
2. Normal view is the default view, where slides are created, edited, and formatted.

3. Slide sorter view provides an overview of the presentation slides to arrange, organize, and sequence them easily.
4. Slide show view is used for presenting slides in full-screen mode to an audience.

5. Animations are effects applied to slide elements (texts, images, etc.) but are not categorized as separate "views."
Knowledge Booster:

- Slide show view is essential for presenting slides full-screen, suitable for audience viewing.

- Slide sorter view is helpful for rearranging slides quickly, showing multiple slides simultaneously.

- Normal view is primarily used for editing and designing individual slides.

Q.48 Which of the following features of MS-Word 2019 lets us create a batch of documents that are personalized for each recipient?

A. Mail Merge

B. Drop Cap

C. Format Painter
D. Smart Lookup

Answer: A

Sol: Mail Merge is the feature in MS-Word 2019 that allows users to create a batch of documents that are personalized for each recipient. It is commonly
used for sending personalized letters, emails, or labels to multiple recipients by merging data from a data source (such as an Excel spreadsheet) with
the document.

Important Key Points:

1. Mail Merge Functionality: Mail Merge enables you to create personalized documents for multiple recipients at once. It combines a template
document with data from a data source (like a spreadsheet) to create individual, customized copies for each recipient.

2. Common Uses: Common uses of Mail Merge include creating personalized letters, invitations, labels, and envelopes, where only certain details
(like the name, address, etc.) change from one document to another.

3. Steps Involved:

o Select the document template.

o Connect to a data source (e.g., an Excel file).

o Insert placeholders (called "merge fields") for personalized data.

o Complete the merge to generate customized documents.

Knowledge Booster:

« Drop Cap: Drop Cap is a feature used to create a large, decorative letter at the beginning of a paragraph, but it does not help in personalizing
documents for recipients.

« Format Painter: Format Painter is used to copy formatting from one part of a document and apply it to another, but it is not used for
personalizing documents.

« Smart Lookup: Smart Lookup allows users to search for more information about a word or phrase from the web or other sources, but it does not
create personalized documents for recipients.

Q.49 What is maximum zoom percentage in MS-Word?

A. 200
B. 400
C. 500
D. 450
E. None of the above

Answer: C
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Sol: The maximum zoom percentage in Microsoft Word is 500%. This feature allows users to enlarge the document view significantly, facilitating close-up
editing, detailed formatting, and easier reading of fine text or graphics.
Important Key Points:
1. Maximum zoom percentage in MS Word is 500%.
2. Users can zoom from as low as 10% up to 500%.
3. Zooming in or out helps users view documents at a comfortable scale for editing and proofreading.
4. Zoom settings do not affect the document's actual content or layout—only the viewing scale is altered.
5. The zoom functionality is accessible via the zoom slider at the bottom-right corner or the "View" tab in the ribbon menu.
Knowledge Booster:
- 200%, 400% or 450% are within the zoom range but do not represent the maximum zoom limit.

Q.50 ROM belongs to which category of computer memory?

A. Register memory
B. Cache memory

C. Primary memory

D. Secondary memory

Answer: C

Sol: ROM (Read-Only Memory) belongs to the category of Primary memory in a computer system. It is a type of non-volatile memory that stores critical
data such as system firmware, which is required to boot up the computer and perform essential functions.
Important Key Points:
1. Primary Memory: Primary memory is the main memory that is directly accessible by the CPU. It stores data and instructions that are actively used
by the system. ROM is part of this memory because it holds essential data like the BIOS or firmware.
2. Non-Volatile Nature: Unlike RAM, which is volatile and loses its data when the power is off, ROM is non-volatile, meaning it retains its data even
when the computer is powered down.
3. Purpose of ROM: ROM typically stores the system'’s firmware, such as the BIOS (Basic Input/Output System), which is essential for booting the
computer and initializing hardware components.
4. Permanent Data Storage: Data in ROM is permanently written during the manufacturing process and is not meant to be altered or written over
under normal circumstances.
Knowledge Booster:
« Register Memory: This is a very fast type of memory located within the CPU itself, used for temporary storage of data during processing. It is not
related to ROM.
« Cache Memory: Cache memory is a small, fast memory located between the CPU and RAM to speed up data access. It is not where ROM is
classified.
« Secondary Memory: Secondary memory refers to storage devices like hard drives, SSDs, and optical discs, which are used for long-term data
storage. ROM is a part of primary memory, not secondary memory.
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